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Introduction

This guide covers both interactive and "silent" installation of Kofax Kapow on Windows, as well as normal
and "headless" installation on Linux.

Before installing Kapow, you must decide whether to install the 32-bit or the 64-bit version. The key
issues to consider are:

= Your operating system may only support one of the versions. 64-bit Windows supports both. On Linux
only 64-bit version is supported.

= The 64-bit version is mainly useful on servers where you want to run RoboServer that uses significant
RAM. (You will need to configure the allowed amount of RAM after installation, as described in the
"Changing the RAM Allocation" section in the Administrator's Guide).

It is possible to install both the 32-bit and the 64-bit versions of Kofax Kapow on the same Windows
computer, and they will share configuration and robots without any extra work on your side. However,
every time you start one of the Kofax Kapow applications, you must take care to start the right version
(32-bit or 64-bit). For Linux, only 64-bit version is provided.

This guide describes:

= How to install Kapow, either interactively or "silently" (without user interaction).

» How to enter license information so that you can start Kapow.

= How to configure Kapow.

= How to set up Kapow server applications to start automatically when the computer restarts.
= How to upgrade from earlier versions.

Getting Help for Kofax Products

Kofax regularly updates the Kofax Support site with the latest information about Kofax products.

To access some resources, you must have a valid Support Agreement with an authorized Kofax Reseller/
Partner or with Kofax directly.

Use the tools that Kofax provides for researching and identifying issues. For example, use the Kofax
Support site to search for answers about messages, keywords, and product issues. To access the Kofax
Support page, go to www.kofax.com/support.

The Kofax Support page provides:
= Product information and release news

Click a product family, select a product, and select a version number.
= Downloadable product documentation

Click a product family, select a product, and click Documentation.


http://www.kofax.com/support

= Access to product knowledge bases
Click Knowledge Base.

= Access to the Kofax Customer Portal (for eligible customers)
Click Account Management and log in.

To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link to
open the Guide to the Kofax Support Portal. This guide describes how to access the support site, what
to do before contacting the support team, how to open a new case or view an open case, and what
information to collect before opening a case.

= Access to support tools
Click Tools and select the tool to use.

= Information about the support commitment for Kofax products
Click Support Details and select Kofax Support Commitment.

Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.



Chapter 1

System Requirements

The tables below specify system specification for different platforms. The requirements may depend on
the application, so these should only be taken as guidelines and not as absolute numbers. A complex
clipping solution might require much more power than a simple collection solution. The recommendations
for servers are for one server. The number of servers used for a given application (the size of a cluster) is
a completely different matter and should be estimated using methods described elsewhere.

IDE requirements:

Minimum

Recommended

Windows

Intel Core Duo 1.8 GHz CPU (or
AMD equivalent), 4GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Intel Core Duo 2.66 GHz CPU (or
AMD equivalent), 8GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Linux (64-bit)

Intel Core Duo 1.8 GHz CPU (or
AMD equivalent), 4GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Intel Core Duo 2.66 GHz CPU (or
AMD equivalent), 8GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Server requirements:

Minimum

Recommended

Windows (32-bit)

Intel Xeon L5520 CPU (or equivalent
AMD Opteron), 2GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Intel Xeon X5680/X5677 CPU (or
equivalent AMD Opteron), 8GB
RAM, 500MB free disk space for
installation and 5GB free disk space
for operation

Windows (64-bit)

Intel Xeon L5520 CPU (or equivalent
AMD Opteron), 4GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Intel Xeon X5680/X5677 CPU (or
equivalent AMD Opteron), 8GB
RAM, 500MB free disk space for
installation and 5GB free disk space
for operation

Linux (64-bit)

Intel Xeon L5520 CPU (or equivalent
AMD Opteron), 4GB RAM, 500MB
free disk space for installation and
5GB free disk space for operation

Intel Xeon X5680/X5677 CPU (or
equivalent AMD Opteron), 8GB
RAM, 500MB free disk space for
installation and 5GB free disk space
for operation

Real-time data: If you have a solution where users are waiting for results in real-time, CPU speed is
normally the bottleneck, and you should buy the fastest CPU available for your hardware platform.
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Dedicated hardware: For best performance, we recommend that you always run RoboServer on
dedicated hardware. That means that you should not run database servers and other services on the
same hardware as your RoboServer.

Operating system: We recommend using the Linux operating system as it is currently faster than
Windows when running Java applications. In some scenarios we have measured up to 33% more
throughput when using Linux.

Supported Platforms

This is the list of supported platforms. Kofax Kapow was tested on the listed versions. To determine if
Kapow works on a version that is not listed, contact Kofax for more information.

IDE Platforms

Windows Windows Server 2008 R2, Windows Server 2012,
Windows Server 2012 R2, Windows 7, Windows 8,
Windows 10

Linux (64-bit) CentOS/Red Hat Enterprise Linux 6.x and 7.x
Ubuntu 14.04 LTS with | i bgt 5webki t 5 library

Server Platforms

Windows Windows Server 2008 R2, Windows Server 2012,
Windows Server 2012 R2

Linux (64-bit) CentOS-7, Red Hat Enterprise Linux 6.x and 7.x, Debian
8.2

Important The minimal Linux installation must include the following packages to be able to run Robots
created with default browser engine.

= |ibX1ll.so0.6
* |[ibG.so.1
= |ibXext.so.6

To use the Device Automation feature, install the | i bxsl t 1. 1 package.
Use the yum i nstal | orsudo apt-get command to install necessary libraries on a Linux platform.

You must also install fonts on a headless Linux server for the webkit robots to work.
= Instructions for installing fonts for CentOS / RedHat
= Instructions for installing fonts for Ubuntu


https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/5/html/International_Language_Support_Guide/add_fonts_all_users.html
https://wiki.ubuntu.com/Fonts
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Device Automation Platforms

Windows Windows Server 2003 SP2, Windows XP SP3, Windows
7, Windows 10

Databases

Oracle* Version 12c
Requires Unicode and case sensitivity. For case-
sensitive comparison, ensure that NLS_COWP is set to
Bl NARY.

IBM DB2 9.7

Microsoft SQL Server Version 2008 and 2008 R2, 2012, 2014

Sybase* Adaptive Server Enterprise 15.0 using the jConnect for
JDBC 3.0 version 6.0.5 driver

MySQL* Version 5.5-5.7

HBase The step Store in HBase Table can be used with HBase
Version 0.90.6.

Note You can use PostgreSQL database only for storing your data. PostgreSQL cannot be used as a
Management Console system or logging database.

APls

Java Java 8 including J2EE servers such as Oracle WebLogic
11, IBM WebSphere, and JBOSS

JMX Java 1.6

.NET C#, .NET Version 4.0

For correct display of data in the Kofax Insight Dashboard, make sure Java correctly sets the time
according to your time zone on RoboServers and computers running Management Consoles. See
the Timezone Data Versions in the JRE Software on the Oracle web site for the latest updates in time
zones. If necessary, use the Timezone Updater Tool to update the time zone information.

Management Console Portals

Tomcat Version 7.0.56 or later. Minimum Java version 1.8 with
the latest update.

Other Supported Technologies

Supported browsers for Management Console and Internet Explorer version 9, 10, and 11; Chrome version
KappZone/Kapplets 31 and later; Firefox version 25 and later; Safari version
7.
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Other Supported Technologies

Supported JMS message brokers

Apache ActiveMQ 5.11, 5.12, 5.13; Red Hat JBoss A-MQ
6.2.1.

* Be aware that loss of data may occur when storing data in Oracle, Sybase or MySQL. On Oracle, an
empty string is converted to null. On Sybase, an empty string is converted to " " (a single space). On
MySQL, millisecond precision is lost when storing dates. For details, see the ObjectKey Caveats section
in the Storing Data in Databases topic in the Kapow help.




Chapter 2

Install Kapow

For the Windows platform, Kofax Kapow has four installers that install different parts of the software:

= Kapow Design Studio installer: Installs Design Studio and documentation (including SQL scripts for
database tables), but does not install RoboServer, Management Console or API. Use this installer if
you have a central Management Console/License Server and need a separate copy of Design Studio.

= Kapow RoboServer installer: Installs RoboServer only and does not install Management Console,
Design Studio, documentation, or API. This installer is useful, if you need to set up dedicated
RoboServer machines.

= Configurable full Kapow installer: Installs all the components, or you can select which ones to install.
= Kapow Device Automation installer: Installs Automation Device Agent to automate remote devices.

The three limited installers can be run using the silent installation process. If you run a silent installation of
the full installer, you get the typical install. See Silent Installation on Windows for details.

For Linux, Kapow provides a full installer and two new r oboser ver service installers that do not install
any other components. See Install on Linux for details.

Upgrading from Earlier Versions

In the interest of stability, different versions of Kofax Kapow may be installed side by side on the same
computer without interfering with each other (except that they must be configured to use different port
numbers for the Management Console if run simultaneously). This means that you can install a newer
version and get acquainted with it while still doing your daily work with the older version.

This also means that important data such as uploaded robots, execution schedules and so on will not be
shared between different versions installed on the same computer. Thus at some point you will need to
copy this data from the old Kofax Kapow installation to the new one. (There is a similar but separate issue
with Design Studio projects as discussed in Upgrade Kapow.)

You copy this data from one version of Management Console to another by making a backup of the
old installation and "restoring" it into the new one. This process is discussed in the Options tab topic
in the Kapow help. Making a backup varies in different versions of Kofax Kapow, so check the online
documentation for the relevant old version to learn how to create a backup.

If you are running Management Console in a Tomcat web server (see the next section), be sure to make
the backup before modifying your Tomcat configuration for the new version of Kofax Kapow.

Management Console on Tomcat

The Management Console is a key part of Kofax Kapow that by default is run as an embedded
component inside the RoboServer application. However, it may also be installed as a regular web
application on a standalone Tomcat web server. If you want to do that (or decide later to switch), you need
to do a number of additional manual steps as described in the "Management Console on Tomcat" section
in the Administrator's Guide.

When running embedded in the RoboServer application, Management Console can use an embedded
derby database. At customer sites, we have seen degraded performance with more that 100 schedulers
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or 500 robots in the embedded Management Console. If you experience degradation, we recommend
deploying Management Console in Tomcat where you can select another database.

Note The derby JDBC driver is not distributed with the Enterprise Management Console. See Apache
Derby Web site for Derby JDBC driver download information. We recommend using MySQL or other
enterprise-class database with your Enterprise Management Console.

If you are upgrading from a previous version of Kofax Kapow where you installed Management Console in
a Tomcat web server, be sure to make a backup of it before you install the new version into Tomcat.

Install on Windows

You can download a required version of installer based on instructions that you received from Kapow.
If you are installing the full Kapow version, download and save the Kapow_10.1.0.2.msi (32-bit) or
Kapow_10.1.0.2_x64.msi (64-bit) file to your hard disk. After the download is completed, run the file
to start the installation and follow the installer prompts. Then proceed to enter license information as
described in Provide License Information.

The full Kapow installer provides the following installation options. Optional items are listed with an
asterisk.

= Design Studio: Installs Design Studio and its required components
= RoboServer: Installs RoboServer

= Embedded Management Console: Installs components needed to run an embedded Management
Console on the RoboServer

= Management Console: Creates the WAR file for manual installation of the Management Console
= Device Automation Service*: Installs the Device Automation feature to automate Windows applications
and terminal computers. This option is required to design and use the Device Automation robots.
= Autostart Device Automation Service*: Creates a link in the Startup menu to start the remote hub at
login.
= Documentation: Installs documentation (including the SQL script files)
= API*: Installs necessary APl components

If you are installing Design Studio only, download and save the Kapow_DesignStudio_10.1.0.2_x32.msi
or Kapow_DesignStudio_10.1.0.2_x64.msi file to your hard disk. After the download is completed, run the
file to start the installation and follow the installer prompts.

To install a RoboServer, download and save the Kapow_RoboServer _10.1.0.2_x32.msi or
Kapow_RoboServer_10.1.0.2_x64.msi file to your hard disk. After the download is completed, run the file
to start the installation and follow the installer prompts.

To install the Automation Device Agent, download and save the
Kapow_DeviceAutomation_10.1.0.2_x32.msi file to your hard disk. After the download is completed, run
the file on the computer you want to automate to start the installation. The Device Automation Service

is installed in autostart mode. Note that you do not need to install the Automation Device Agent to
automate terminals. The RoboServer that runs robots with Device Automation steps must be installed on
a Windows system.

As another option, you can use the silent installation to automate the installation process.

1
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Note You need administrator rights to install Kapow on Windows.

Install on Linux

Kapow provides two installers:
= Configurable full Kapow installer: Installs all the components or you can select which ones to install.

= Kapow RoboServer installer: Installs the r oboser ver service only and does not install Management
Console, Design Studio, Documentation, or API.

Running the Full Installer

You can download a required version of the installer based on instructions that you received from Kapow.
Download and save the Kapow_10.1.0.2_x64.tar.gz for the Linux 64-bit version.

When the download is completed, the installation is done by extracting the contents of the file. In most
Linux distributions, this can be done by right-clicking the file and selecting the appropriate extraction
option. The file can also be extracted from the command line as follows:

$tar xzf Kapow 10.1.0.2_x64.tar.gz
Alternatively, to extract the file to a specific directory, use the following command:
$tar xzf Kapow 10.1.0.2 x64.tar.gz -C /destination_directory

When the file is extracted, proceed to enter license information as described in Provide License
Information.

Note You can install Kapow as an unprivileged user on Linux.

Running RoboServer Installer

The RoboServer only installers are created for the deb and rpm packages. The default installation folder
for these packages is / opt / Kapow .

Each of the RoboServer packages contains a RoboServer launcher that is used to run RoboServer as a
Linux /et c/init.d service. This makes it automatically start on system boot.

The packages create a kapow user and group in the system used when running the roboserver
/etc/init.d service. The configuration files (most importantly r oboser ver. set ti ngs) for the
RoboServer service are located in the kapow users home directory (/ home/ kapow ) under the hidden
directory .Kapow <ver si on>.

The r oboser ver. setti ngs file can also be accessed through / et c/ opt / Kapow RoboSer ver . conf .
To see all available commands, just run RoboServer from / et ¢/ i ni t. d without any arguments.

By default, the RoboServer starts with an SSL port listening (the port number is defined in the
roboserver. settings file). Keep in mind that this is a RoboServer only install; it is not possible for the
service to be configured to start a Management Console, such as with the -MC parameter, which is done
via the full installation of Kapow.

Torun roboserver asainit.d service:

1. Install the RPM or DEB package.
2. Change the roboserver configuration (optional).
3. Run#service RoboServer start, or restart the machine to start the service automatically.
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Silent Installation on Windows

A silent installer runs without user interaction. This is convenient if, for instance, you need to automate the
installation process in a script.
Using Full Installer
To perform a silent installation of Kofax Kapow, run the following command with administrative rights:
msi exec /gqn /i Kapow_10. 1.0. 2. nsi
This installs the program to the default location. To specify another location, use a command as follows:
msi exec /gqn /i Kapow_10.1.0.2.nsi | NSTALLDI R="dir"
where "di r" is the location where you want to install. For example:
msi exec /qn /i Kapow_10.1.0.2.nsi | NSTALLDI R="C:\ Kapow 10. 1. 0.2 x64\"
To install the Kapow Remote Hub, run the installer with the following parameters:
msi exec /qb /i Kapow_10.1.0. 2. nsi ADDLOCAL=Renot eHub
To specify a file to log the installation process, use the following parameter:
msi exec /qn /i Kapow_ 10.1.0.2.nsi /| nsilog.txt
After installation, proceed to enter license information as described in Provide License Information.
Using Limited Installers
The following are examples of using Design Studio and RoboServer silent installers:
nmsi exec /qn /i Kapow _Desi gnStudi o _10. 1. 0. 2. nsi
nmsi exec /qn /i Kapow_RoboServer 10. 1. 0. 2. nsi

Important Folders in Kapow

We recommend that you become familiar with the folders and files described in this section.

Installation Folder

The installation folder is the folder where Kofax Kapow is installed. On Windows, the installation folder
defaults to:

C.\ Program Fi | es\ Kof ax Kapow 10.1.0. 2
On Linux it will be a directory named Kapow_10.1.0.2 in the directory where you extracted the archive.
The installation folder contains the following important folders:

bin

Contains all executable programs for Kofax Kapow.

API

Contains files and documentation related to the Kofax Kapow Integration APls.

13
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lib/jdbc
Contains the installed JDBC database drivers. These drivers are always available in Kofax Kapow

applications. Normally, you should manage JDBC drivers as described in the Database Drivers topic
in the Management Console section of the online help.

Project Folder

The project folder contains your library of robots and types, as described in the Design Studio topic of the
online help. Configure the location of the project folder with the Settings application as described in the
Working with Projects and Libraries topic of the Design Studio help. On Windows, the default location is
similar to the following, depending on your Windows version:

C.\ Docunments and Settings\ username\ My Docunents\ My Robots\10.1.0.2
C:\ User s\ usernane\ Docunment s\ My Robot s\ 10.1.0.2

On Linux the default location of the project directory is:

~/ Kapow/ 10.1.0. 2

The project directory must contain a single subdirectory named Library.

Application Data Folder

The application data folder contains files that are private to the Kofax Kapow but which differ for different
users of the same computer. On Windows, the application data folder is (depending on your Windows
version):

C.\Docunments and Settings\ usernane\Local Settings\Application Data\Kapow 10.1.0.2
C:\ User s\ usernane\ AppDat a\ Local \ Kapow 10. 1. 0. 2

On Linux the application data folder is:

~/ . Kapow 10.1.0. 2

To change the location of the application data folder, you can edit the common.conf file in the installation
\bin folder. You should add these two lines:

wr apper . j ava. addi ti onal . 10=- Dkapow. appl i cat i onDat aFol der =" Fol der cont ai ni ng
Configuration fol der"

wr apper.java. addi tional . 10. stri pquot es=TRUE
Make sure that the user running Kofax Kapow has read and write access to the folder.
Under normal circumstances, you should never modify or delete files or folders within this folder directly;

the GUI tools should be used instead. The application data folder contains the following important folders:

Certificates

Contains the HTTPS certificates known by Kofax Kapow. See the "Certificates" section in the
Administrator's Guide for more information.

Configuration

Contains configuration files, which are maintained as described in the section Configuring Kofax
Kapow.

Data

Contains the embedded Derby database used by the Management Console (except when installed
as a web application in a Tomcat web server). See "Management Console on Tomcat" chapter in the
Administrator's Guide.

14
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DemoDatabase

Contains the Development Database used in the Management Console Beginner Tutorial, and which
you can also use in "toy projects" during your introduction to Kofax Kapow.

Logs

Contains log files.

15



Chapter 3

Third-Party Components

The topics in this chapter describe which third-party components must be installed and configured for
Kapow to work properly.

Install Components for Kapow Remote Hub

Kapow Remote Hub is designed to work with native applications (including Java applications) on
Windows systems. The following components and configuration steps are required for the Kapow Remote
Hub to access applications on Windows.

Make sure that the latest Windows operating system updates are installed. For Windows 7, 8, and 8.1,
the KB2999226 update is required. If this update is not installed on your system, download it from the
Microsoft website and install according to the provided instructions.

Note The KB2999226 update is not required for Windows XP.

To work with Java applications, check the following.

= Install the latest Oracle Java 32-bit (JRE or JDK) that installs the Java Access Bridge 32-bit dlls. The
Java applications started by the robots can run in a 64-bit JVM, but the 64-bit installer does not include
the 32-bit dlls. If your corporate policy does not allow upgrading the Oracle Java, manually install the
files needed for Java Access Bridge support as follows.

Java Access Bridge Installation on Windows 64-bit

1. Ensure JAWS 13 or later is installed on your system. Note that JAWS version 13.0.527 or later is
required for Windows 7 64-bit. You can download this component from the Java SE Downloads
page http://www.oracle.com/technetwork/java/javase/downloads/index.html.

2. Download Java Access Bridge 2.0.2 from the Java Access Bridge download page at the following
URL:
http://www.oracle.com/technetwork/javal/javase/downloads/jab-2-0-2-download-354311.html

3. Extract the Java Access Bridge to a folder in your drive and copy W ndowsAccessBri dge- 32. dl |
to [ W NDOWBHOVE] \ SYswowe4. Where WINDOWSHOME s the directory where Microsoft Windows
is installed, for example, C: \ W NDOWS.

Java Access Bridge Installation on Windows 32-bit
1. Ensure JAWS 13 or later is installed on your system. You can download this component from the
Java SE Downloads page http://www.oracle.com/technetwork/java/javase/downloads/index.html.

2. Download Java Access Bridge 2.0.2 from the Java Access Bridge download page at the following
URL:

http://www.oracle.com/technetwork/javal/javase/downloads/jab-2-0-2-download-354311.html

16
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3. Extract the Java Access Bridge to a folder in your drive and copy W ndowsAccessBri dge- 32. dl |
to 9\ NDONSHOVE% SYSTEMB2. Where %W NDOWSHOVE%is the directory where Microsoft Windows is
installed, for example, C: \ W NDOWS.

Note For detailed Java Access Bridge installation instructions, see Installing Java Access Bridge on
the Oracle web site.

= Enable the Java Access Bridge by selecting the Enable Java Access Bridge option in the Control
Panel > Ease of Access Center > Use the computer without a display or by running the
following command prompt command in the bi n directory of the Java JRE installation directory:
j abswi t ch. exe /enabl e.
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Chapter 4

Provide License Information

The first step after basic installation is to enter license information. See the following pages for information
on where to enter a license key in Management Console and Design Studio, respectively. It is not
necessary to enter license information in the RoboServers, as they automatically receive the necessary
license information from Management Console.

Management Console (License Server)

Before you can enter license information into Management Console, you need to start it.

Windows
Use the Start Management Console item in the Start menu.

To start the Management Console from the command line, run the following command in the bin subfolder
of the installation folder.

RoboServer -p 50000 - MC

Linux

Start Management Console from the command line. It is part of the RoboServer program, which is found
in the bin directory under the installation directory (see Important Folders in Kapow).

$. / RoboServer -p 50000 - MC

Auto-start

As an alternative, if you later set up auto-start of the Management Console as described in Start Servers
Automatically, you may select to do that now instead of starting Management Console manually.

Once the Management Console is started, you must open its GUI in a browser. On Windows, you can
do that with the aid of the Management Console item in the Start menu. On all platforms, you can open
a browser and go to http://localhost:50080/. Accept the license terms and enter your license information,
including your license keys.

Design Studio

If Design Studio is not already started, do as follows:

Windows
Use the Design Studio item in the Start menu.

18
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To start the Design Studio from the command line, run the following command in the bin subfolder of the
installation folder.

Desi gnSt udi o
Linux

Start Design Studio from the command line by launching the Desi gnSt udi o program in the bin directory
under the installation directory (see Important Folders in Kapow) as follows:

$. / Desi gnSt udi o

On the next screen, enter your license information.

You have three choices, depending on what information you have been provided from Kofax Kapow and/
or your system administrator:

License Server

If your administrator provided you with the URL to a central license server (Management Console)

that administers the license for all Design Studio users, select License Server and enter the URL and
credentials for that server. The license server must be running and have available Design Studio seats in
order for you to use Design Studio.

Developer License

The developer license is a combined license key for both Management Console and Design Studio.
You can either enter the license key in your local Management Console, or use the dialog box in Design
Studio. Whenever you start Design Studio, the Management Console will automatically start as well.

Trial License

The trial license works in the same way as the developer license, but is intended for short-time use for
trial/demonstration purposes.

Normally, Design Studio displays the Enter License Information dialog box only the first time it is
started. It will, however, display this dialog box again if the license server cannot be contacted because it
has been moved, is not running, or is unavailable for another reason.
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Chapter 5

Kapow Initial Configuration

After installing Kofax Kapow, configure the installation to suit your needs. Some configuration is
done using the Settings application as described in the "RoboServer Configuration" section of the
Administrator's Guide.

Important For correct display of data in the Kofax Insight Dashboard, make sure Java correctly sets

the time according to your time zone on RoboServers and computers running Management Consoles.
See the Timezone Data Versions in the JRE Software on the Oracle web site for the latest updates in
time zones. If necessary, use the Timezone Updater Tool to update the time zone information.

Other configuration tasks, relevant mostly for administrators of the Kofax Kapow system, are done via
Management Console, more specifically via the Servers tab, the Projects tab and the Options tab. It is
especially important to set up the necessary RoboServers and clusters on the Servers tab. Refer to the
Administrator's Guide and the Management Console section in the Kapow help for information on Kapow
configuration.

Start Servers Automatically

If your installation includes any server functionality, you can configure it to start the necessary servers
automatically.

The server functionality includes RoboServers and the Management Console (license server). These two
components are provided by the RoboServer, depending on the arguments given to it during startup.

Refer to the following sections for information on how to start your servers on Windows and Linux
systems.

= Start Servers on Windows
= Start Servers on Linux

Start Servers on Windows

To make RoboServer start automatically on Windows, add it as a Windows service. We will show how
to add and remove Windows services using the Ser vi cel nst al | er. exe program included in the Kofax
Kapow installation.

Adding Windows Services

To run RoboServer as a service, you need to install it first using the Servicelnstaller.exe program. The
following is a general example outlining the command-line arguments to this program (although displayed
on multiple lines here, this is a one-line command):

Servicelnstaller.exe -i RoboServer.conf w apper.ntservice.account=Account
Wr apper . ntservice. passwor d. pronpt =true w apper. ntservice. nane=Servi ce-



nanme wrapper.ntservice.starttype=Start-nethod w apper. sysl og. | ogl evel =I NFO
wWr apper . app. paranet er. 1="Fi rst- Argunent" wr apper. app. par anet er. 2="Second- ar gunent "

wrapper.ntservice.account

The account of the user that has to run RoboServer. Kapow stores configuration in the user's
directory and it is important to choose a user that has the correct configuration.

If RoboServer has to run as a domain user, you need to enter the account in the form domai n
\ account

If RoboServer has to run as a regular user, you need to enter the account in the form . \ account

Note For security reasons, do not use the Local Syst emaccount for the RoboServer service's
login. If Local Syst emis used, the following error occurs when webkit (default) robots run: "Could
not establish connection to WebKitBrowser. Failed to connect to bus."

wrapper.ntservice.password.prompt

The value true prompts the user for the password for the account. If you prefer to enter the password
on the command line, you must instead use wr apper . nt ser vi ce. passwor d=<passwor d>.
wrapper.ntservice.name

The name of the service to install. The name of the service cannot contain spaces.

wrapper.ntservice.starttype

AUTO_START if the service should be started automatically when the system is restarted.
DELAY_START if the service should be started after a short delay. (Not supported on Windows XP
and 2003).

DEMAND_START if to start the service manually.

wrapper.syslog.loglevel
Redirect the console output from RoboServer to the event log.

wrapper.app.parameter.*

The arguments for RoboServer. You can enter as few or as many as needed. For a list of RoboServer
arguments, please refer to the Starting RoboServer section in the Administrator's Guide.

When the service is installed, the user is granted the "log on as a service" rights. If the service fails to
start, check that the right is granted by opening gpedit.msc and (on Windows 7) navigate to Computer
Configuration > Windows Settings > Security Settings > Local Policies > User Rights Assignment
> Log on as a service and add the user.

The following are examples of installing RoboServers in different configurations:

= This script creates a Windows Service that only starts the Management Console. This is the
recommended configuration as the Management Console should run under its own JVM if possible.
The name of the Windows Service can be changed as needed:

Servicelnstal l er. exe -i RoboServer.conf w apper.ntservice.account=.
\ USER_NAME_HERE wr apper. nt servi ce. password. pronpt =true

wr apper . nt servi ce. name="RoboServer 10. 1. 0. 2_MC"

wWr apper . ntservice. starttype=AUTO_START wr apper. sysl og. | ogl evel =l NFO
Wr apper . app. par anet er. 1="- MC"

= The following scripts install services that start two RoboServers: one on port 50000 and the other on
50001. The service name can be different:
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Servicelnstal l er.exe -i RoboServer.conf w apper.ntservice.account=.

\ USER_NAME_HERE wr apper. nt servi ce. password. pronpt =true

wr apper . nt servi ce. nanme="RoboSer ver 10. 1. 0. 2_50000"

wWr apper . ntservice.starttype=AUTO_START w apper . sysl og. | ogl evel =I NFO

Wr apper. app. paraneter. 1="-servi ce" w apper.app. paranet er. 2="socket : 50000"

Servicelnstall er.exe -i RoboServer.conf w apper.ntservice.account=.
\ USER_NAME_HERE wr apper. ntservi ce. password. pronpt =true
wr apper . nt servi ce. nanme="RoboServer 10. 1. 0. 2_50001"
wr apper . ntservice.starttype=AUTO_START w apper. sysl og. | ogl evel =I NFO
wWr apper . app. paraneter. 1="-servi ce" w apper. app. paranet er. 2="socket: 50001"
Removing Windows Services
To uninstall a service, run the following command:
Servi celnstal |l er. exe -r RoboServer.conf w apper.ntservice. nane=<Servi ceNane>
wrapper.ntservice.name
The name of the service to remove.

Example:

This example removes a service named RoboServer10.1.0.2

Servi celnstal |l er. exe -r RoboServer.conf w apper.ntservice. nane="RoboServer 10. 1. 0. 2"

Start Servers on Linux

The simplest way to make RoboServer start automatically on Linux is to use crontab. Use the following
command to create or edit the list of scheduled jobs in Linux for the desired user (it may be easiest to do
this either as root account or as that particular user):

crontab -u soneUser -e

To the list of scheduled jobs add for example:
@ eboot $HOVE/ Kapow_10. 1. 0. 2/ bi n/ RoboSer ver -p 50000

or
@ eboot $HOME/ Kapow_10. 1. 0. 2/ bi n/ RoboServer -p 50000 - MC

This way the RoboServer program is started with the indicated command-line arguments upon reboot.
Note that you must identify the bin directory under the actual installation folder.
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Chapter 6

Upgrade Kapow

In the interest of stability, different versions of Kofax Kapow may be installed side by side on the same
computer without interfering with each other. This means that you can install a newer version and get
acquainted with it while still doing your daily work with the older version. While doing so, you will probably
want to open the older version's default robot project in the newer Design Studio. If you save a robot with
the newer version, you will not be able to open it with the older version of Design Studio.

Important If you use the APl in your Kapow environment, the Java and .NET files must be updated
when upgrading Kapow. The new API files are located in the API folder of your Kapow installation
folder, such as C: \ Progr am Fi | es\ Kof ax Kapow 10. 1. 0.2 x64\ API .

Below we will list the most important differences between Kofax Kapow versions that you should take into
account when upgrading.

Upgrade Linux Installation
Read the Upgrade a Linux Installation topic if you are upgrading to a newer version on a Linux machine.

10.1

Version 10.1 of Kapow is backward compatible with 10.0. Your current robots should run in Kapow version
10.1. See Changes in Behavior in Kapow Release Notes.

9.7

Version 9.7 of Kapow is backward compatible with 9.6. Your current robots should run in Kapow version
9.7.

9.6
Read Upgrade to Version 9.6 topic if you are upgrading to Kapow version 9.6.

9.5
Read Upgrade to Version 9.5 topic if you are upgrading to Kapow version 9.5.

9.3

Version 9.3 of Kapow is fully backward compatible with 9.2 and your current robots will run with the
Classic Browser Engine as in 9.2. For more information see Customers Upgrading From 9.2.

9.2

Version 9.2 of Kapow introduces new capabilities for extracting data from Microsoft Excel™ files. You will
find advice on how to use these instead of the old ones in the section on New Excel Capabilities in 9.2.

9.1

Version 9.1 of Kapow no longer includes the RoboRunner application. You will find advice on how to use
Management Console instead in the section on RoboRunner Discontinued in 9.1.
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Upgrade a Linux Installation

This section provides details about how to upgrade your Kofax Kapow product in a Linux environment.
Perform the following steps to upgrade your Linux installation of Kapow.

Stop the roboserver manually and wait for robots to finish executing (optional).

Update the packages.

Change the configuration in the new r oboser ver. set ti ngs file (optional).

Restart the computer or use RoboSer ver Servi ce start command to restart the roboserver.

PN

Note the following when upgrading Kapow on Linux:
= Upgrading a package replaces all the files in the / opt / Kapow' directory.

= When you start the upgrade procedure, the i ni t. d service is stopped and replaced with a new
version. The service is stopped immediately without waiting for robots to finish executing. If you do not
want to interrupt the execution of the robots, stop the roboserver manually before upgrading.

= Anew roboserver. settings file is created for the new service. The new file is created in / hone/
kapow . Kapow <r el ease_ver si on>/ Confi gur ati on/ similarly to the old one. That means a new
directory is created for the new release so that the old configuration file remains intact in the folder with
the older release name. The link to the configuration file in / et ¢/ opt / Kapow RoboSer ver . conf points
to the settings file in the last installed release.

= The configuration from the old r oboser ver . set ti ngs file is not transferred to the new one, this must
be done manually.

Upgrade to Version 9.6

Upgrade Existing Robots to 9.6

A legacy wait criteria is added to Robots from previous versions (9.3, 9.4, 9.5) using the "Max. Wait for
Timer Events" and "Wait Real-Time for Timer Events" for backward compatibility and ensuring the same
behavior as in 9.5. This cannot be edited, but it can be removed and replaced with new criteria to improve
performance if possible.

. ¥
Cantinue wher: Legacy Timing (vvait max, 10000 ms real-time for timer &...

L = B

To switch to the new default settings when updating an existing robot to 9.6, go to the File > Configure
Robot dialog box, click the Advanced tab and clear the Use Pre 9.6 Default Waiting check box.
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EE'_ Robot Configuration 2

* Basic * Advanced De=ign Mode Version

Proxy Server. Use Proxy Server: [

Host

Uzername

| |
Port number: | |
| |
1 |

Pazsword

Excluded hosts: |localhost
127.004

Use Pre 9.6 Defautt Wating: * [

Enakle Private HTTP Cache: [+

Private HTTP Cache Size (KE): |2EI4B |

[ ter | ok || caneer |

Upgrade to Version 9.5

Log Database

The log database format has changed in version 9.5, therefore if you want to use your 9.4 or older log
database with Kapow 9.5, you must drop tables in your current database before using it with version 9.5.
Follow the procedure to update the tables in your database:

1.  Start the previous version Management Console and create a backup.

Stop your Management Console.

Backup the old logdb, if needed.

Drop the tables of the old logdb.

Start the Management Console version 9.5 and import the backup.

Dl ol
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Customers Upgrading From 9.2

Kapow version 9.3 and 9.4 are fully backward compatible with 9.2 and your current robots will run with the
Classic Browser Engine as in 9.2, there is no need to migrate existing working robots to the new Default
browser. We currently recommend building new robots using the Default browser, but in case the web site
does not render in the Default browser, we recommend switching to Classic. This will particularly be the
case for legacy web applications design for compatibility with previous versions of Internet Explorer.

Please note that the Default browser is using Chrome as the browser to emulate, while the Classic
browser emulates Internet Explorer. This can cause Classic and Default to render pages differently and
return a different Document Object Model (DOM), so when migrating from a Classic to a Default robot, the
tag-finders may be different and require modification.

Before upgrading a production environment to a new version, we always recommend testing the new
version. We will be happy to provide non-Production license keys enabling you to perform the necessary
testing. For more information about data migration from earlier versions see Data Migration Tutorial.

Data Migration Tutorial

In this tutorial we will perform a test migration of existing Kapow data from version 9.2 to version 9.3 of
the Kapow solution. We strongly recommend you to create a test setup to perform a migration, before you
work with your production environment to ensure that Robots, restored in a new version of Kapow, do not
interfere with your production process and database.

Note If you are using a Kapow version prior to 9.2, there are other considerations that are outside of
this tutorial. Please contact Kapow technical support for assistance in migrating from version prior to
9.2.

Kapow version 9.2 and later use the new Kapow compute units licensing model as well as our centralized
application settings, which are handled through the Management Console Ul.

Most of the migration can be performed using the Admin > Backup tabs in the Management Console. In
this tutorial we use MySQL as a data source for the project.

Any settings made in the RoboServer Settings application must be reset using the same application in the
new version of the Kapow product.

Important For all the steps in this tutorial, including making changes in the RoboServer Settings
application, we strongly recommend to use one and the same account that will be used later to run the
new version of the Kapow application as a service on Windows or as a process on Linux.

Perform the steps of the following procedure to migrate your Kapow application data.

1.  Start the Management Console version 9.2, open it in the browser, and perform a backup of your
entire inventory. Later you will restore schedules, robots, types, etc. in the new version of Kapow.

1. In the Management Console, go to the Admin > Backup tab.

2. Click Create Backup under Full Backup/Restore and confirm your action.



This action will create a .zip backup file with all the configuration settings stored by the
Management Console.

Note Kapow stores its data in the application data folder located under a Windows user folder
of the user who is currently logged in the system. Because Kapow stores some of its important
information in the data folder and because this information is relevant to the user account, we
recommend you to include Kapow application data folder to your normal file backup procedure.
For more information about Kapow folders, see the

Important Folders in Kapow

Start your new version of the Management Console from the command line window. You should start
the Management Console without starting the RoboServer by using the following command in the
bin subfolder of the Kapow installation folder:

RoboServer -MC

The command window will show you the Management Console connector TCP port. The default
port number is 50080. If you changed the TCP port using the RoboServer Settings application, the
number you specified should appear in the command line window when the Management Console is
being started.

Important Use the same account to start the command line interface and run the Management
Console to ensure Kapow service has access to all the necessary files and folders.

Start the Management Console in the browser. If you use the same browser to switch between
different versions of the Management Console, you might get the Unable to start application error
with the The response could not be deserialized message. To avoid this shared browser cache
issue, either use different browsers (for example, Internet Explorer and Chrome) for different
versions of Kapow Management Console or you can try to just click OK and reload the page.

Note Once the Management Console is loaded, look for the version of the Console you are
working with in the left top corner to make sure you working with the version 9.3 of the product.

Go to Admin > Backup tab and click Restore Backup. Specify the path to the zip backup file you
created in your previous version of Kapow and click Restore. Once the restore process is complete
click Close to close the Restore Backup dialog box.

Perform the following in the Management Console:

1. On the Admin > Clusters tab, check that any listed RoboServers are not started. This action
ensures that the new version of the Management Console does not connect to any of the
previous version robots that you used when creating a backup in your previous version of the
Management Console.

2. On the Admin > Clusters tab, right click the cluster name and select Cluster Settings....
Specify a database different from the one that was set in the previous version. If you made a
backup from your production environment, this step ensures that your new robots would not
interfere with your production database. You can choose to use the same database, but change
the schema. It is strongly recommended to keep the name of the database without changing,
because the imported robots will be looking for this label when running. Click OK and select to
stop all robots and apply settings.

3. On the Admin > Settings tab, click RoboServer Log Database and change the schema to a
new clean version. Test the connection and save the settings.



Note If the specified logging database is empty, the application creates necessary tables when
it connects to the database.

4. Check the Schedules tab and disable any scheduled runs that you do not want to be running.

6. On the Admin > Clusters tab, click Add Server to add a new server and assign this server to the
production cluster. In this tutorial we will add a server that runs on the same machine where we run
the new version of the Kapow Management Console. You can also specify a port number different
from those you used for RoboServers in your previous version, for example, 50001.

The server you added appears offline in the Cluster/Server list until we start it with the specified port.

7. Open the command line window where you started the Management Console and stop the process
(Ctrl C).

8. Start the Management Console and the RoboServer with the port you specified using the following
command:

RoboServer -MC -p 50001

Once the RoboServer is started, you can see the version of the server listed in the Cluster/Server list
on the Clusters tab.

9. Create necessary tables in your new database. You can use database tools to populate tables from
your production database, or you can use the Design Studio to create necessary tables. You must
specify the same database for the cluster in the Management Console and for the project in Design
Studio. To create the tables using the Design Studio, download and save necessary Types and
Robots from the Management Console to your new project folder, open the project in Design Studio,
specify all the database settings, and allow the Studio to create necessary tables in the database.
To check that the tables are created, go to the Data tab in the Management Console and look for the
tables in the selected database.

10. If you imported any Kapplets from your previous version, go to Kapplets>Repository in the
Management Console and enable the Kapplets you want to use. Once the Kapplets are enabled,
you can open the KappZone and check whether the Kapplets can be opened and run.

Important After you complete the migration, perform a thorough examination of your existing
processes in the new version of Kofax Kapow to confirm that everything is functioning as expected.
For any questions during migration and verification testing, contact Kapow technical support by
sending an email to support@kapowsoftware.com

New Excel Capabilities in 9.2

Since the way Excel is handled in 9.2 fundamentally different from the way that Excel was handled

in previous versions of Design Studio it is important to know that there is no simple way to upgrade
robot from earlier version to 9.2 when these involves Excel. It may involve a considerable amount of
rewriting. This is because in previous versions Excel was transformed into HTML during loading and
subsequent extraction etc. was then done in the same as for HTML, but in 9.2 Excel is loaded into the
new Spreadsheet Page View and dedicated steps are used for data extraction from this.
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The Convert Excel to HTML Legacy Option

Old robots still works since there is a legacy option called Convert Excel to HTML that allows this and

old robots have this option turned on by default. If you want to upgrade a robot to use the new Excel
capabilities you have to turn this option off. You do this under Robot Configuration by clicking the
Configure Options button and on the Legacy tab of the Configure Option dialog box you clear the
option. But changing this would, unless you do not do any extraction or looping that works on the Excel,
break your robot. You will have to go through your robot and replace some of the step with the new
dedicated Excel steps where ever the robot work on the data from the loaded Excel document. So unless
you have compelling reasons for upgrading your old robots to use the new Excel capabilities you should
probably not do it. This does not mean that you cannot upgrade your robot to use other 9.2 feature, just
that you should leave the legacy option turned on.

Note The Convert Excel to HTML option is always set in your old robot even if it did not involve any
Extract from Excel steps or Excel in any other way. It is important to remember this in case you load
an old robot into 9.2 and use this as your starting point for building a new robot, because if you do not
turn off the Convert Excel to HTML option then you will not be able to take advantage of the new Excel
capabilities.

The Extract from Excel Step Action is Deprecated

The Extract from Excel step action has been deprecated and cannot be used in new robots instead you
should use a Create Page step action for this.

RoboRunner Discontinued in 9.1

As previously announced, the RoboRunner application is no longer supported. This guide will show you
what to do instead.

The task of scheduling robots at given intervals is now handled by the Management Console, which is a
web based application. We will look at each of the different RoboRunner execution scenarios, and how
these tasks are done using the Management Console. Before you proceed any further, we recommend
that you read the Management Console chapter in online help, as we will be referring to it in great detail
later.

Although the robots are scheduled by the Management Console they are in fact executed on a
RoboServer. You can read more about the RoboServer in the Administrator's Guide. The RoboServer can
be monitored using the Management Console dashboard.

Scheduling concepts

RoboRunner had two ways of executing robots:

The -file option
If your robots were scheduled individually using RoboRunner, you will have to create a separate schedule

for each robot to have it run at the desired time, as described here. Scheduling robots this way has an
added benefit, as you can now parametrize your robots using input objects.
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If you have multiple robots that need to run at the same time, you can create a schedule by selecting the
robots on the Robots Tab in Management Console, right clicking and selecting Create Schedule from
the context menu.

Deploy to Management Console

Once you have structured your robots, you are ready to deploy them to Management Console. The
deployment procedure is different for different versions of Kapow.

If you are deploying your robots in Kapow version 9.5 and later, just connect to a Management Console
from your copy of Design Studio and upload the project to the selected Management Console. For more
information, see Management Consoles and Working with Shared Projects topics in the Design Studio
section of the online help.

If you are deploying your robots in Kapow version prior to 9.5, create a Project Export from within Design
Studio. To create a Project Export, perform the following steps:

1. Right click the project folder in the project view, and select Create Project Export on the context
menu.

2. Select a location where you want to store the project export, and click OK.

3. If any of your robots were developed before version 8.1, expand any . nodel files you may still have.

You can read more about types and models in New Variables and Type System in 8.1. Also, names
of robots in a project must be unique even if they are located in different sub-folders. A dialog box
will inform you if there are any name conflicts.

Once you have created the project Export, open the Management Console and go to the Options
Tab (Admin > Options) to perform the Project Import.

Robots Schedule

Once your robots are uploaded, you can create schedules to execute your robots.

If your robots use the old database storage system (Database Storage/Message/Info Environment), you

will have to configure options on the Legacy tab of the New Schedule Dialog. However, we recommend
that you rewrite these robots to use the new storage paradigm introduced in 7.2. You can read about the
new storage system at New Storage System in 7.2.

The new storage system includes a new and improved database logging system, which is integrated into
the Management Console, and allows you to 'jump' directly from a schedule to the errors generated by
the robots. This will work in parallel with the legacy Message Environments, but again we recommend
that you rewrite your robots, since the Storage/Message Environments will be removed from the product
at some point in the future.
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